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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

Siemens AG
Division Process Industries and Drives
Postfach 48 48
90026 NÜRNBERG
GERMANY
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Introduction 1
These instructions contain all information required to commission and use the device. Read 
the instructions carefully prior to installation and commissioning. In order to use the device 
correctly, first review its principle of operation.

The instructions are aimed at persons mechanically installing the device, connecting it 
electronically, configuring the parameters and commissioning it, as well as service and 
maintenance engineers.

The contents of this manual shall not become part of or modify any prior or existing agreement, 
commitment or legal relationship. The sales contract contains all obligations on the part of 
Siemens as well as the complete and solely applicable warranty conditions. Any statements 
regarding device versions described in the manual do not create new warranties or modify the 
existing warranty.

The content reflects the technical status at the time of publishing. Siemens reserves the right 
to make technical changes in the course of further development.

1.1 Preface
These instructions contain all the information you need for using the device.   

The instructions are aimed at persons mechanically installing the device, connecting it 
electrically, configuring the parameters and commissioning it, as well as service and 
maintenance engineers.

Note

It is the responsibility of the customer that the instructions and directions provided in the 
operating instructions are read, understood, and followed by the relevant personnel before 
installing the device.

1.2 History
The following table shows the most important changes in the documentation compared to each 
previous edition.

Edition Remarks FW version EDD version
2003 First edition with product release 1.02 1.01.04
12/2009 Update with FW 1.04 1.04 1.01.04
10/2010 Update with FW 1.05 1.05 1.01.04
09/2011 Update with FW 2.03 2.03 1.02.07

FUS380/FUE380
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Edition Remarks FW version EDD version
09/2013 ● Restructure this document

● Adding transmitter information
2.03 1.02.07

09/2016 ● Restructure this document
● Updates for SIMATIC PDM 8.2

2.03 1.02.08-01

The FUS080 is configured in a combination of hardware (HW) and firmware (FW). For 
communication and parametrization via SIMATIC PDM the correct version of the EDD driver 
for FUS/FUE 380 is needed. The various relations are listed above. 

These Operating Instructions describe FW version 2.03 and EDD version 1.02.08-01 (with min. 
SIMATIC PDM V8.2).

1.3 Items supplied
The device can be delivered as either a compact or a remote system.

Compact system

● Sensor SITRANS FUS300
● Transmitter SITRANS FUS080 or FUE080
● Siemens Process Instrumentation 

documentation disk containing certificates, 
and manuals

● Safety note
● Calibration report m
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Remote system

● Sensor SITRANS FUS300
● Transmitter SITRANS FUS080 or FUE080
● Siemens Process Instrumentation 

documentation disk containing certificates, 
and manuals

● Safety note
● Calibration report
● Wall/pipe mounting kit with bracket and 

terminal box
● 4 Transducer coaxial cables
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Note

Scope of delivery may vary, depending on version and add-ons. Make sure the scope of 
delivery and the information on the nameplate correspond to your order and the delivery note. 

1.4 Checking the consignment
1. Check the packaging and the device for visible damage caused by inappropriate handling 

during shipping.

2. Report any claims for damages immediately to the shipping company.

3. Retain damaged parts for clarification.

4. Check the scope of delivery by comparing your order to the shipping documents for 
correctness and completeness.  

1.5 Device identification
The FUS380 or FUE380 flowmeter is delivered with different labels (nameplates) on the 
transmitter and sensor. The transmitter and sensor are matched paired. 

The transmitter has two nameplates. One (silver) is placed on the front of the transmitter. The 
transmitter system nameplate (white) is placed on the right side of the transmitter. Both provide 
valuable information about the device and system. The sensor system nameplate (white) is 
placed on middle of the sensor.

Note
Identification

Identify your device by comparing your ordering data with the information on the product and 
specification nameplates.

Introduction
1.5 Device identification
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Transmitter system nameplate

1.000000

123412H123

123412H123FDK:087H2503

2.03

2015

M15

① System number (order code identifying selected options and system serial number)
② Transmitter production code and serial number 
③ Sensor production code and serial number
④ Maximum flow value (qs), Nominal flow value (qp), Minimum flow value (qi)
⑤ Pulse value (output A)
⑥ Pulse width (output A)
⑦ Cable length (one transducer cable); Software version
⑧ Calibration factor; Production year
⑨ Ambient temperature range
⑩ Type approval number (shown on FUE380 versions only)
⑪ Accuracy class (shown on FUE380 versions only)
⑫ Environmental class (shown on FUE380 versions only)
⑬ Verification markings (shown on MID-verified FUE380 versions only)

Figure 1-1 Transmitter system nameplate, FUE380 example

Introduction
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Sensor system nameplate

SITRANS FUE380
Sensor

Dimension
Process Con.
qs
qp / qi
Θmin − Θmax
Cal. Factor
T-amb.
(PS) at +15 °C 
(PS) at +200 °C (TS)
Fluid group

FDK-087H2503
123412H123
DN 200
EN 1092-1, PN16
500 m3/h
250 / 5 m3/h
+15 °C ... +200 °C
1.000000
-10 to +55 °C
       16 Bar
       13.5 Bar
       PED/G2

SYSTEM No.

Prod. Year

7ME3410-2FC22-4BR2

123412H123
2015

0200
0200M15

Siemens A/S, Flow Instruments, 6430 Nordborg, Denmark

Made in France

Accuracy Class:      2
Certification No.:     DK-0200-MI004-005

Environmental Class:      E2, M1

① Sensor production code and serial number
② Dimension (nominal size ordered)
③ Process connections
④ Maximum flow value (qs)
⑤ Nominal flow value (qp), Minimum flow value (qi)
⑥ Water temperature range
⑦ Calibration factor
⑧ Ambient temperature range
⑨ Maximum allowable working pressures at 15 °C (59 °F) and 200°C (392 °F) (max. tempera‐

ture (TS))
⑩ Fluid group
⑪ System number (order code identifying selected options and system serial number)
⑫ Production year
⑬ Certification number (shown on FUE380 versions only)
⑭ Accuracy class (shown on FUE380 versions only)
⑮ Environmental class (shown on FUE380 versions only)
⑯ Verification and PED markings (verification marking shown on MID-verified FUE380 versions 

only)

Figure 1-2 Sensor system nameplate, FUE380 example

Note
The matched paired transmitter and sensor shall be mounted together

At installation, please check that the system nameplates of transmitter and sensor have the 
same system serial number. 

Introduction
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1.6 Further Information

Product information on the Internet     
The Operating Instructions are available on the documentation disk shipped with the device, 
and on the Internet on the Siemens homepage, where further information on the range of 
SITRANS F flowmeters may also be found:

Product information on the internet (http://www.siemens.com/flow) 

Worldwide contact person   
If you need more information or have particular problems not covered sufficiently by these 
Operating Instructions, get in touch with your contact person. You can find contact information 
for your local contact person on the Internet:

Local contact person (http://www.automation.siemens.com/partner) 

Introduction
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Safety notes 2
2.1 General safety instructions

CAUTION

Correct, reliable operation of the product requires proper transport, storage, positioning and 
assembly as well as careful operation and maintenance.

Only qualified personnel should install or operate this instrument.  

Note

Alterations to the product, including opening or improper modifications of the product are not 
permitted.

If this requirement is not observed, the CE mark and the manufacturer's warranty will expire.

2.2 Lithium batteries
Lithium batteries are primary power sources with high energy content designed to provide the 
highest possible degree of safety.  

WARNING

Potential hazard

Lithium batteries may present a potential hazard if they are abused electrically or 
mechanically. Observe the following precautions when handling and using lithium batteries:
● Do not short-circuit, recharge or connect with false polarity.
● Do not expose to temperatures beyond the specified temperature range.
● Do not incinerate.
● Do not crush, puncture or open cells or disassemble.
● Do not weld or solder to the battery’s body.
● Do not expose contents to water.

2.3 Laws and directives

General requirements     
Installation of the equipment must comply with national regulations. For example EN 60079-14 
for the European Community.

FUS380/FUE380
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Instrument safety standards   
The device has been tested at the factory, based on the safety requirements. In order to 
maintain this condition over the expected life of the device the requirements described in these 
Operating Instructions must be observed.

NOTICE

Material compatibility  

Siemens Flow Instruments can provide assistance with the selection of wetted sensor parts. 
However, the full responsibility for the selection rests with the customer and Siemens Flow 
Instruments can take no responsibility for any failure due to material incompatibility.

CE-marked equipment
The CE mark symbolizes the compliance of the device with the following directives:

● EMC-directive 2004/108/EC

● Low voltage directive 2006/95/EC

● Pressure equipment directive (PED/DGRL) 93/23/EC

● ATEX Directive 94/9/EG

2.4 Installation in hazardous area

WARNING

NOT allowed for use in hazardous areas!

Equipment used in hazardous areas must be Ex-approved and marked accordingly!    

This device is NOT approved for use in hazardous areas!

WARNING

500 V insulation test

The device is not capable of withstanding the 500 V insulation test required by Clause 6.3.12 
of EN60079-11. This must be taken into account when installing the device.

2.5 Certificates
You can find certificates on the Internet at online support portal (http://www.siemens.com/
processinstrumentation/certificates) or on an included DVD.

Safety notes
2.5 Certificates
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Description 3
3.1 Overview

The SITRANS F US ultrasonic flowmeter systems consist of a sensor and a transmitter. This 
system consists of sensor type FUS300 or SONOKIT and the transmitters type FUS080 or 
FUE080. The transmitter type FUS080 is for the standard flowmeter series SITRANS FUS380 
or SONOKIT series. The transmitter type FUE080 is for the type-approved flowmeter series 
SITRANS FUE380 with the custody transfer approval for use in energy metering systems. The 
transmitters are designed to measure flow in water applications.

The ultrasonic flowmeter transmitter comes as battery or mains-powered version. 

The following table shows the ultrasonic flowmeter systems with these transmitter types:

Sensor type Transmitter Flowmeter system
FUS300 (2-path)
DN 50 – DN 1200 

FUS080 FUS380 

FUS300 (2-path)
DN 50 – DN 1200 (with custody transfer approval 
for use with heatmeters)

FUE080 FUE380

SONOKIT (1- or 2-path)
DN 100 – DN 1200

FUS080 SONOKIT (1-path / 2-path)

These Operating Instructions are only for the FUS380 and FUE380 flowmeter system. The 
FUS080 for SONOKIT and the SONOKIT sensors have separate Operating Instructions.

3.2 System components
The flowmeter system includes:

● Battery or mains-powered transmitter (FUS080 or FUE080)

● Sensor FUS300 as 2-path sensor with flanges and inline transducers wet-calibrated from 
factory together with the transmitter (DN 50 (2") to DN 1200 (48"))
or the retrofitting set SONOKIT (1-path for pipe diameters from DN 100 (4") up to DN 1200 
(48") or for 2-path from DN 200 (8") up to DN 1200 (48")).

FUS380/FUE380
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3.3 Design
The transmitter type SITRANS FUS080 is designed with fiberglass reinforced polyamide 
enclosure for remote or compact installation in normal areas. The remote versions are available 
with up to 30 meter distance from flowmeter to transmitter. When ordered as a compact version 
in the series FUS380 and FUE380 the transducer cables are pre-mounted at the sensor.

SITRANS FUS080 transmitter SITRANS FUS080 Display

The transmitter is available in an IP67/NEMA 4X/6 enclosure and is designed for use in the 
flowmeters series:

● SONOKIT (1-path or 2-path)

● FUS380 (2-path)

● FUE380 (2-path)

For spare part cases the transmitter is always ordered as part of a complete flowmeter system, 
it can be ordered preprogrammed with the given sensor data (system serial number).

3.4 Features
The following features are available:

● Battery or mains-powered transmitter

● Battery-powered with 3.6 V Lithium dual D-cell batteries

● Suitable for sensor pipe diameters from DN 50 (2") up to DN 1200 (48")

● IP67 (NEMA 4X/6) rated polyamid transmitter enclosure

● Factory preset to the nominal dimensions of pipe type and pipe size

● Programming via SIMATIC PDM

● Local control panel with single push button, 8-digit display and IrDA optical interface for 
communication with SIMATIC PDM

● Display showing accumulated volume as well as instantaneous flow rate. The displayed 
units are m3 and m3/h

● Two digital outputs for volume pulse or alarm

Description
3.4 Features
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Applications
The main application for flowmeters type SITRANS FUS380 / SONOKIT and the type-
approved version FUE380 is measurement of water flow in district heating plants, local 
networks, boiler stations, substations, chiller plants, irrigations plants, and other general water 
applications.

Integration
The flowmeter pulse output is often used as input for an energy meter or as input for digital 
systems for remote reading. The transmitter has two pulse outputs, with functions that can be 
individually selected, and integrated IrDA (optical eye) communication interface (Modbus RTU).

The settings of the transmitter, for example flow and pulse output rate, are defined when 
ordering the complete flowmeter. If the flowmeter forms part of an energy meter system for 
custody transfer, no further approvals are needed, except eventually local approvals on the 
flowmeter.

Transmitter communication solutions
The transmitter supports Modbus RTU communication via the optical IrDA interface at the 
display, enabling the change of different transmitter settings using the SIMATIC PDM software 
tool.

The FUS080 is configured in a combination of hardware (HW) and firmware (FW). For the 
communication and parametrization via SIMATIC PDM a firmware-specific electronic device 
description (EDD) is needed. The various relations are listed below:

FW version EDD version
1.02 to 1.05 1.01.04 (with SIMATIC PDM 6 versions)
2.03 1.02.07 (with SIMATIC PDM 6 versions)
2.03 1.02.08-01 (min. SIMATIC PDM 8 versions)

This operating instruction is about the FW 2.03 and related EDD 1.02.08-01 (with min. SIMATIC 
PDM 8.2).

Description
3.4 Features
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3.5 Principle of operation

Physical principle   

Figure 3-1 Velocity distribution along sound path

A sound wave travelling in the same direction as the liquid flow arrives at point B from point A 
in a shorter time than the sound wave travelling against the flow direction (from point B to A).

The difference in sound transit time indicates the flow velocity in the pipe.

Since delay time is measured at short intervals both in and against flow direction, temperature 
has no influence on measurement accuracy.

SITRANS F US flowmeters
In SITRANS F US flowmeters the ultrasonic transducers are placed at an angle θ in relation 
to the pipe axis. The transducers function as transmitters and receivers of the ultrasonic 
signals. Measurement is performed by determining the time the ultrasonic signal takes to travel 
with and against the flow. The principle can be expressed as follows:

v = K × (tB,A – tA,B) / (tA,B × tB,A) = K × Δt/t²
where
v = Average flow velocity
t = Transit time
K = Proportional flow factor      

This measuring principle offers the advantage that it is independent of variations in the actual 
sound velocity of the liquid, i.e. independent of the temperature.

The mechanical/geometrical pipe data is transducer angle (θ), distance between sensors (L) 
and pipe dimension (Di and Du) shown in the figure below. 

Description
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1A

1B

Figure 3-2 Measuring principle

The ultrasonic signal is sent directly between the transducers. The advantage gained by 
sending signals from point to point is an extremely good signal strength.

Description
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Installing/Mounting 4
4.1 Flowmeter installation

The flowmeter installation is done in two steps: 

1. Sensor installation

2. Transmitter installation

Environment
SITRANS F flowmeters are suitable for indoor and outdoor installations.

● Make sure that temperature and ambient specifications indicated on the device type plate/
label are not exceeded.    

CAUTION

Direct sunlight

Device damage.

The device can overheat or materials become brittle due to UV exposure.

Protect the device from direct sunlight.

Make sure that the maximum permissible ambient temperature is not exceeded. 

Refer to the technical data in FUS380 and FUE380 systems (Page 79).

Ambient temperatures for FUS080:

● MID version: -10 to +55 °C (14 to 131 °F)

● Non-MID version: -10 to +60 °C (14 to 140 °F)

See also Insulation (Page 26).

The enclosure rating of the transmitter is IP67 (NEMA 4X/6) or better.

4.2 Sensor installation

4.2.1 Inlet/outlet conditions
Requirement for straight inlet before flowmeter

In order to maximize performance it is necessary to have straight inlet and outlet flow conditions 
before and after the flowmeter.

Furthermore, a minimum distance between flowmeter and pumps and valves must be 
respected.

FUS380/FUE380
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It is also important to centre the flowmeter in relation to flanges and gaskets.

Make sure that the flowmeter is positioned as low as possible to prevent air from being trapped 
in the flowmeter at the transducers.

Find a position on the pipeline where the inlet pipe tothe  flowmeter has a straight length as 
specified below.

Note
MID-approved FUE380 systems

Minimum straight inlet pipe: 1.5 m. See further recommendations below.

Single bend
1 x 90° bend

L2: Min. 10 x pipe diameter

L1: 3 x pipe diameter

Dual bend
2 x 90° bends in the same plane

L2: Min. 10 x pipe diameter

L1: 3 x pipe diameter

Installing/Mounting
4.2 Sensor installation
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Triple bend
3 x 90° bends in two planes

L2: Min. 20 x pipe diameter

L1: 3 x pipe diameter

Valves and pumps
Valves

L2: Min. 10 x pipe diameter, fully open valve

L1: 3 x pipe diameter

Partially opened valves

L2: Min. 40 x pipe diameter, partially opened valves (or equal valves design) 

Pumps

Installing/Mounting
4.2 Sensor installation
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L2: Min. 20 x pipe diameter

L1: 3 x pipe diameter

Orienting the sensor
Horizontal orientation: sensors with terminal box must be mounted with the terminal box in 
upwards or downwards position. Sensor without terminal box (remote versions) must be 
mounted with the transducers in the vertical plane.

In horizontal installation avoid any upward/downward position of the transducers.

Installing/Mounting
4.2 Sensor installation
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Precautions
Avoid installation at the highest point in the system because air bubbles will be trapped in the 
flowmeter.

Avoid installation at a point where there is a free outlet after the flowmeter.

The flowmeter pipe section may be installed in either a horizontal or vertical position.

Note

To obtain maximum battery lifetime of the Lithium Thionyl Chloride battery pack, Siemens 
recommends installing the flowmeter transmitter in an upright position.

Installing/Mounting
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4.2.2 Reduction

Installation in large pipes
The flowmeter can be installed between two reducers as shown. At 8° reducing angles the 
below pressure drop curve applies.

Delta-P example:
A water flow velocity of 3 m/s (V) in a sensor with a diameter reduction from DN 200 to DN 
100 (D1/D2 = 0.5) gives a pressure drop of 9 mbar.

L2: Min. 10 x pipe diameter

4.2.3 Insulation
Siemens always recommends insulation of the sensor in both the compact and the remote 
versions. This recommendation applies to both battery-powered and mains-powered versions. 
The insulation will prevent heat transfer to the transmitter (compact versions) or terminal box 
(remote versions).

Installing/Mounting
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For media temperatures above 120 °C (248 °F) only remote installation is allowed.

Temperatur specifications for non-insulated sensors
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4.3 Transmitter installation (compact/remote versions)
The transmitter is packed separately - ready for plug-in into base part.
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There are two mounting versions of the transmitter (as shown in figures below):

● remote transmitter

● compact transmitter

Safety N
ote

m
nn

m
nm

n

nm
mn

nm
mn

mn
nm

nm
n

nm
mn

nm
mn

mn
nm

nm
n

mn
mn

nm
nm

n

m
nn
m
nm

nn

m
nn
m
nm

n

m
nn
m
nm

nn

m
nm

nn

mn
nm

nn

nn
mn

mn
m

nn
m

nm
n

nm
mn

nm
mn

mn
nm

nm
n

nm
mn

nm
mn

mn
nm

nm
n

mn
mn

nm
nm

n

m
nn
m
nm

nn

m
nn
m
nm

n

m
nn
m
nm

nn

m
nm

nn

mn
nm

nn

nn
mn

mn

Safety N
ote

Note

The matched paired transmitter and sensor shall be mounted together. At installation, please 
check that the system nameplates of transmitter and sensor have the same system serial 
number.

4.3.1 Installation wall mounting kit (remote transmitter)
Mount wall/pipe mounting bracket in an appropriate place.

Note

Take the connection cable length into consideration, and allow adequate space for the cable 
inlets.
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4.3.2 Battery-powered transmitter
The battery-powered transmitter is prepared for one battery pack of 2 lithium 3.6 V D-cell 
batteries and a single backup battery. The battery lifetime depends on the use of the different 
functions, for example the use of Modbus IrDA communication or higher pulse output frequency 
will decrease the lifetime significantly. Under normal temperature and working conditions a 
battery can have an operation lifetime of up to 6 years. The typical liftetime of a dual battery 
pack with nominal working pulse output frequency of 20 Hz is approximately 4.2 years.

Siemens recommends replacing batteries after maximum 6 years. For the replacement, see 
Battery replacement (Page 63) and Start-up routine (Page 47). Every time a battery plug is 
reconnected, the unit runs a start-up routine, see Start-up routine (Page 47).

Note

The male battery plug is not connected upon delivery. This connection must be made to enable 
the back-up battery power supply.

Note

Changing the battery does not influence the settings and accumulated values.

Installing/Mounting
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Connecting 5
SITRANS FUS380 and FUE380 is delivered in one of the three versions:

● Battery-powered only

● Mains-powered

● Mains-powered with battery back-up

Determine the transmitter power source type by reading the label or via the product code.

NOTICE

Verification sealing

SITRANS FUE380 systems are protected by a verification sealing. The verification sealing 
must only be broken by the user with the acceptance of the local authorities. 

Note
Power supply

A transmitter ordered as only battery-powered cannot be updated with additional mains power, 
as no mains power supply circuits are installed in this transmitter type.

WARNING

Skills

Only qualified personnel may carry out work on the electrical connections.

WARNING

Danger of electric shock!

Never install the device with the mains voltage switched on!

5.1 Mains-powered transmitter
The mains-powered transmitter can be ordered with a pre-mounted single back-up lithium 
battery. In the event of power failure, the battery will take over the power supply of the unit.

The battery is not rechargeable; it must be replaced after maximum 6 years.

Note

The male battery plug is not connected upon delivery. This connection must be made to enable 
the back-up battery power supply.
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5.2 Compact system
Connect the compact flowmeter using the following steps.

Connecting battery (battery-powered versions and mains-powered versions with back-up battery)
Plug in male battery plug. Ensure that the wire is inserted into the small channel leading from 
plug to battery.

Preparing connection
Remove protection cover carton from the terminal box.

Connecting power supply cable (mains-powered versions only)

WARNING

Power supply requirements

Make sure the power supply requirements stated on the nameplates are met!

WARNING

Wire insulation   

The insulation between the connected mains supply and the low voltage supply for the 
flowmeter must be rated with at least double or reinforced insulation at mains voltage.

For field wiring installation: Ensure that the National Installation Code of the country in which 
the flowmeters are installed is met.

Note
Conductor terminal     

The wire size for the output terminals are AGW24 to AGW14 or 0.205 mm2 to 2.080 mm2.

Connecting
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1. Replace blind plug with cable gland.

2. Push power supply cable through open gland.

3. Connect power supply to L1, N and protective earth (PE) and tighten cable strap (C).

C

4. Tighten cable gland for power supply cable (approx. 20 Nm).

Connecting output signal cable(s)
If no output signals are needed, proceed with "Finishing connection".

CAUTION

Pulse output

The pulse output must be connected to equipment complying with Low Voltage Directive in 
order to be considered safe. The isolation within FUS080 pulse output is only a functional 
isolation.

1. Replace blind plug with cable gland (if two output signals are required, use a double entry 
cable gland).

2. Push output cable(s) through open gland.

Connecting
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3. Connect output cable(s). 

4. Tighten cable gland for output cable(s) (approx. 20 Nm).

Note
Cables with voltage

Keep the output signal cable(s) separated from cables with voltages > 60 V.

Note
Ingress protection

To guarantee the IP67 (NEMA 4X/6) degree of protection, use cables with the required 
specifications.

Note
Protected terminal     

The wire size for the output terminals are AGW24 to AGW14 or 0.205 mm2 to 2.080 mm2.

Note
EMC performance

Incorrect fixing of the output cable shield will affect the EMC performance!

Connecting
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Finishing connection
Mount the transmitter.

Note
Grounding

To ensure identical potential for sensor and transmitter, a direct grounding of transmitter and 
sensor is recommended.

5.3 Remote system
Connect the remote flowmeter using the following steps.

5.3.1 Sensor side

Preparing connection
Remove the four transducer protection cups.

Preparing connection

Note
Shortened cables

Due to given settings and nameplate data, it is recommended not to shorten the cables. If the 
cables are required to be shortened, all cables must be shortened equally, and the factory set 
cable length must be changed accordingly in the transmitter.

Connecting
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NOTICE

Verification sealing

For SITRANS FUE380 systems, the cable length setting is protected by a verification sealing. 
The verification sealing must only be broken by the user with the acceptance of the local 
authorities.

Connecting transducer cables
1. Wiring the transducer cables.

The system SITRANS FUE380/FUS380 transmitter is supplied with 4 separate transducer 
coaxial cables for 2 paths.
The cables can be used on all transducers, but can be marked for a specific transducer 
(cables are not paired with a specific transducer). The cables are manufactured with crimp 
on the cable ends for the connection board.
Connect each transducer cable to the sensor. Tighten the transducer cable glands to ensure 
they are firmly sealed! Recommended torque for each sensor gland is approx. 20 Nm.
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2. Snap out the connection plate and loosen the grounding wire.
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3. Smoothly push the cables one by one from underneath the base through the glands and 
adjust all cable ends approximately 100 mm from the upper frame of base. 

Note

Make sure that the right cable gland entries are used: 
● Terminal 2A is connected to transducer 2A
● Terminal 2B is connected to transducer 2B

Connecting
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Figure 5-1 Wiring diagram, base of connection board
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4. Mount the connection board back in wall mounting kit and connect the grounding wire plug 
to the grounding terminal (PE) on the PCB.

5. Tighten both transducer cable glands to ensure they are firmly sealed (recommended 
torque: approx. 20 Nm)

Finishing sensor connection
If required, make user sealing at the ransducer glants (typically for FUE380).

Note
Hot surfaces

Ensure that the transducer cable does not come into contact with hot sensor/metering tube.

Note
Grounding

To ensure identical potential for sensor and transmitter, a direct grounding of transmitter and 
sensor is recommended.

Connecting
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Note
Bending transducer cables

Make sure that the transducer cables are not overbent. Minimum cable bend radius is 50 mm. 

5.3.2 Transmitter side

Connecting battery (battery-powered versions and mains-powered versions with back-up battery)
Plug in male battery plug. Ensure that the wire is inserted into the small channel leading from 
plug to battery.

Connecting power supply cable (mains-powered versions only)

WARNING

Power supply requirements

Make sure the power supply requirements stated on the nameplates are met!

Note
Conductor terminal     

The wire size for the output terminals are AGW24 to AGW14 or 0.205 mm2 to 2.080 mm2.

Connecting
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WARNING

Wire insulation   

The insulation between the connected mains supply and the low voltage supply for the 
flowmeter must be rated with at least double or reinforced insulation at mains voltage.

For field wiring installation: Ensure that the National Installation Code of the country in which 
the flowmeters are installed is met.

1. Replace blind plug with cable gland.

2. Push power supply cable through open gland.

3. Connect power supply to L1, N and protective earth (PE) and tighten cable strap (C).

C

4. Tighten cable gland for power supply cable (approx. 20 Nm).

Connecting output signal cable(s)
If no output signals are needed, proceed with "Finishing connection".

CAUTION

Pulse output

The pulse output must be connected to equipment complying with Low Voltage Directive in 
order to be considered safe. The isolation within FUS080 pulse output is only a functional 
isolation.

1. Replace blind plug with cable gland (if two output signals are required, use a double entry 
cable gland).

2. Push output cable(s) through open gland.
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3. Connect output cable(s). 

4. Tighten cable gland for output cable(s) (approx. 20 Nm).

Note
Cables with voltage

Keep the output signal cable(s) separated from cables with voltages > 60 V.

Note
Ingress protection

To guarantee the IP67 (NEMA 4X/6) degree of protection, use cables with the required 
specifications.

Note
Protected terminal     

The wire size for the output terminals are AGW24 to AGW14 or 0.205 mm2 to 2.080 mm2.

Finishing connection
Mount the transmitter.
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Note
Grounding

To ensure identical potential for sensor and transmitter, a direct grounding of transmitter and 
sensor is recommended.

5.3.3 Wiring energy calculator
An energy calculator is typically connected via the pulse output A (terminals 56 and 57) of the 
transmitter.

For example, connection to the energy calculator SITRANS FUE950 can be found in the 
operating instruction of the FUE950.

5.4 Sealing of FUE380

5.4.1 User sealing
After finishing the installation and electrical connection of SITRANS FUE380 types, it is 
recommended to seal the flowmeter as shown.

Transmitter
Sensor
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5.4.2 Verification sealing
These illustrations show how the device is verification sealed.
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On  sensor body

Note
For type-approved and verified FUE380 flowmeters

The HW key is located behind the display and is thereby protected by the display sealing.

The verification sealing may only be broken with the acceptance of the local authorities.
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Commissioning 6
Commissioning the device:

Resetting the battery lifetime, see Start-up routine (Page 47).

It is recommended to read the basic guide to the local display and the menu structure in 
Operating the local display (Page 45) and Commissioning via PDM (Page 48) before 
commissioning the device.

6.1 Operating the local display
The local display is divided into 3 areas:   

● Top area with symbols for status information

● Mid area with actual readings

● Lower area with index number of the shown menu or the service menu symbol (  ).

Activate the push button to go the next index menu and related information. The service menu 
is accessible from all menus by pressing the push button for minimum 2 seconds.

Figure 6-1 Operating the local display

Table 6-1 Status information symbols

Symbol Description
Mains power supply connected

Battery charge status

Warning
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Battery status
There are two symbols for battery charge status:

● "Battery full" indicates battery charge above the warning level (6-year hour counter).

● "Battery low" indicates battery charge below the warning level and that the battery should 
be replaced. 

Note

"Battery low" only indicates that battery charge is below a pre-set level, not that charge is zero.

Flow measurement continues uninterrupted until the battery is completely drained.

Table 6-2 Battery status information symbols

Symbol Description
Battery status, full

Battery status, low

6.2 Navigating the menu structure
Press the push button briefly (less than 2 seconds) to navigate between the following menu 
items:

Table 6-3 Menu items   

Menu Parameter Display example Comments
Menu 1 Flow volume totalizer 1 Factory preset is forward vol‐

ume flow.
The battery symbol shows 
full.

Menu 2 Flow volume totalizer 2 FUS380 - The menu 2 is acti‐
vated and shows totalizer 2 
for the reverse accumulated 
volume.
FUE380 - The menu 2 is de‐
activated, but with ordered Z-
option E21 the menu 2 shows 
totalizer 2 for the reverse ac‐
cumulated volume.

Menu 3 Actual flow rate Negative values indicate re‐
verse flow calculation.
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Menu Parameter Display example Comments
Menu 4 Alarm codes Each code refers to a specific 

alarm.

Menu 5 Display test Check of all segments. Dis‐
play toggles between all seg‐
ments on/off.

6.3 Start-up routine
1. Power-up device.

2. Reset battery status indicator as described below.

Resetting the battery counter   
When a new battery is installed and the plug is connected, the transmitter start-up routine 
begins. The display shows the active software version, e.g. 2.03.

After ten seconds the message "reset.bat" will appear.

1. Press push button within six seconds to reset the internal battery counter. The message 
"accept" will appear.

2. Press push button again within six seconds in order to reset the internal battery counter. 
The battery indicator now shows full. If the push button is not pressed again, the battery 
indicator will show "Low".

Figure 6-2 Reset internal battery counter
* Firmware version, here version 2.03
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6.4 Commissioning via PDM
SIMATIC PDM (Process Device Manager) is a software package for configuring, 
parameterizing, commissioning, and maintaining field devices (for example transducers).     

Among other features, SIMATIC PDM contains a simple process for monitoring process 
values, interrupts and status/diagnosis signals of a field device.

Note

For instructions on installation and operation of SIMATIC PDM, refer to the SIMATIC PDM 
Getting Started (included in the documentation package that comes with PDM).

Note
PDM requirements

Minimum PDM version required is SIMATIC PDM V8.2 + SP1

Note
Default password

Any data changes in PDM requires a password. The default password is 1000. For further 
information, see Password-protected data (Page 60).

Note
HW key protected parameters

For type-approved and verified FUE380 flowmeter the settings are HW key protected and can 
be only read, but not changed via PDM. The HW key is located behind the display and is 
thereby protected by the display sealing. The verification sealing may only be broken with the 
acceptance of the authorities.

In the following it is described how the device is commissioned using SIMATC PDM.

The commissioning is divided into the following steps:

1. Installing and connecting the IrDA interface adapter (Page 49)

2. Installing the device driver (Page 50)

3. Adding the device to the network (Page 52)

4. Configuring the device (Page 53)

5. Optimizing the system (Page 54)

6. Checking the operation readiness (Page 57)

Commissioning
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6.4.1 Installing and connecting the IrDA interface adapter

Note
IrDA driver installation

For installation of the IrDA driver, refer to the instructions delivered with the adapter.

1. Connect IrDA adapter to PC

2. Mount adapter on FUS080

When the IrDA adapter is connected correctly, a small icon appears on the taskbar of your 
PC. When the mouse is placed on this icon, the device information will be shown (e.g. [FUS080 
SN1033 is in range]).
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6.4.2 Installing the device driver
Install the PDM device driver as follows:     

1. Close SIMATIC PDM (if already open).

2. Open Device Integration Manager from [Start → All Programs → Siemens Automation → 
SIMATIC → SIMATIC PDM].
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3. Click on [I accept the License Agreement].

4. Click on  or  depending on whether the source is zipped or not.

5. Browse to the folder where the source files are located and click on the folder.

6. The device will show up in a tree view. Mark the device to be installed and click on  to 
install the driver on the PC.

Note
Please use for the firmware FW 2.03 the related EDD 1.02.08-01.
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6.4.3 Adding the device to the network
It is recommended to configure the FUS080 project in PDM before setting the parameters. 

Add device to SIMATIC Modbus network: 

1. Select [File → New]
Type in a project name.

2. Right click on your new project, select [Insert New Object → Networks].

3. Right click on your Networks, select [Insert New Object → Communication Network].

4. Click on [Assign Device Type] and select Networks → MODBUS → MODBUS networks → 
MODBUS network.

5. Click [OK] and click [OK] again.

6. Right click on MODBUS network and select [Insert New Object → Object]

7. Click on [Assign Device Type] and assign the MODBUS device to SITRANS FUS/E080 
[Devices → MODBUS → Sensors → Flow → Ultrasonic → SIEMENS AG → SITRANS FUS/
E080] and click [OK].
Name device according to application requirements (max. 32 characters) and click [OK].
Set up communication parameters for SIMATIC MODBUS network.

8. Select Networks → MODBUS network.

9. Right click on Modbus network and select Object Properties.

10.On the Communication tab, select MODBUS communication to activate IrDA.
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6.4.4 Configuring the device
In the following it is described how to configure the device by defining all sensor specific 
parameters.

Note
Measurement accuracy

A correct flowmeter installation is required to ensure optimum measurement accuracy.

Read all parameters
Before any parameterization is done it is necessary to read all parameters from the device into 
the offline table of SIMATIC PDM. The offline table merely contains default data.

1. Open PDM device driver.

2. Select Upload to PG/PC .. and click [Start] to read all parameters to the offline table. 
After closing the dialog box, all loaded parameters should show  (Loaded) in the status 
of the PDM table; except date and time formats, they show  (Changed).  

3. Store factory set default values on your local PC [File → Export] in order to be able to retrieve 
default settings.
 

Read, write device data
Only parameters (data) shown with white background can be changed.

Note
Status field
●  indicates changed off-line data not yet stored in the device.
●  indicates actual data downloaded to the device.
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Load the parameters to the device by clicking on . Check the option [Load changed 
parameters only] to speed up the communication and avoid errors.

For overview of the parameters see Parameter lists.

6.4.5 Optimizing the system
After storage of the settings, the parameters can be set according to use.

The following shows how to set Pulse Output A and Qmax. For other parameters, refer to 
"Parameter list" in the appendix.
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Setting Pulse Output and Maximum Flow (Qmax) via SIMATIC PDM
1. In SIMATIC PDM navigate to menu [Device → Pulse guide].

The "guide" calculates the pulse-frequency at the max flow condition and tells you how 
close you are on over-speeding the pulse-output. 
The volume per pulse is freely scalable from 0.000001 to 10000 units per pulse. It also 
calculates the minimum volume per pulse you can choose to avoid pulse over-speeding. 
The maximum output frequency depends on the pulse selected; e.g. maximum output 
frequency at 5 ms is 100 Hz. Increasing the pulse width lowers the maximum output 
frequency.

2. Select maximum flow rate (never to be exceeded).

3. Select an appropriate pulse width, e.g. 5 ms.

4. Enter a value in Amount per pulse A, e.g. 100, to define the volume/pulse with respect to 
the Minimum amount per pulse value.

5. Press [Apply Change of Pulse] to apply the settings.

6. If needed, proceed with setting Pulse Output B according to application specific 
requirements (Default setting = Alarm).

Output A and B setting
For FUS380 and FUE380, output A and B settings depend on the ordering: Recommended 
settings, see the following table. Settings for FUS380 can be read out and changed via 
SIMATIC PDM (Process device manager). The FUE380 settings cannot be changed according 
approval requirements, and are therefore read only.

 FUS380 FUE380
Output A Forward or reverse pulses

Preset: Forward
Forward or reverse pulses
Preset: Forward setting is HW locked

Output B Forward or reverse pulses, alarm, call-
up
Preset: Alarm

Forward or reverse pulses, alarm, call-
up
Preset: Alarm setting is HW locked

Pulse value A & B
(depending on DN value)

Preset: Depending on ordered configu‐
ration. Setting is noted on nameplate.
Available settings: 0.1 l/p; 0.25 l/p; 0.5 l/
p; 1 l/p; 2.5 l/p; 10 l/p; 25 l/p; 50 l/p; 100 
l/p; 250 l/p; 500 l/p; 
1 m3/p; 2.5 m3/p;
5 m3/p; 10 m3/p; 25 m3/p; 50 m3/p; 100 
m3/p; 250 m3/p; 500 m3/p; 1000 m3/p

Preset: Depending on ordered configu‐
ration. Setting is noted on the name‐
plate. Setting is HW key locked. Note: 
The setting shall be equal to the connec‐
ted energy calculator.

Pulse width Setting options: 5; 10; 20; 50; 100; 200; 
500 ms 
Preset: Depending on ordered configu‐
ration. Setting is noted on the name‐
plate.

Setting: Depending on ordered configu‐
ration. Setting is noted on the name‐
plate. 
Typical preset: 5 ms.
Setting is HW key locked.
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Note
HW key protected parameters

For type-approved and verified FUE380 flowmeter the settings are HW key protected and can 
be only read, but not changed via PDM. The HW key is located behind the display and is 
thereby protected by the display sealing. The verification sealing may only be broken with the 
acceptance of the authorities.

6.4.6 Output A, terminals 56/57:
The pulse rate can be seen on transmitter side label (system nameplate).

The settings are dependig on the ordering. The following table shows the typical recommended 
pulse output settings (pulse width 5 ms) for the energy calculator SITRANS FUE950

For optimal benefit, the pulse value and pulse length must be selected as low as possible. The 
following calculation formula can be used for determining the lowest pulse value at a pulse 
length of 5 ms:

L/pulse > Qs (m3/h)/360

For example Qs = 300 m3/h; L/pulse > 300/360; L/pulse > 0.83; therefore the pulse value must 
be 1 l/pulse (nearest possible ordering selection). 

See also the pulse guide in PDM [Device → Pulse guide (offline)].

Table 6-4 Recommended pules values for FUE950

DN Pulse setting (liter/pulse)
50 1
65 1
80 2.5
100 2.5
125 2.5
150 10
200 10
250 10
300 50
350 50
400 50
500 100
600 100
700 100
800 100
900 100
1000 100
1200 100
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6.4.7 Output B, terminals 66/67:
The output B setting must be selected according to application specific requirements (default 
setting = Alarm).

Preset to alarm indication:

Example: If track 1 is not measuring, a  appears on display. Failure code F1 appears in 
display menu 4, and relay output terminals switch to Off.

Call up indication:

When output B is configured as Call-up, the output is activated by an alarm condition and 
remains on until it is manually reset via communication interface and the PDM program (or via 
manually power down of the device).

A new alarm will not activate a Call-up function if the Call-up function is still active from a 
previous alarm. 

6.4.8 Checking the operation readiness
All parameters are now set and defined according to the application.

1. Select: [Device → Download to device...] to download the parameters to the device.

Note

Before downloading the parameters, check that all listed data are loaded or changed and 
in accordance with the application requirements.

2. Click [Start] to download all changes from the table to the device.

Commissioning
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View process values   
The system is now ready for normal operation. 

1. Select [View → Process Variables] to see all measured process values.

2. Verify that the fields show the expected values.

Note
Measured Track Values

The Measured Track Values should show stable values within the normal range, i.e. the gains 
should be stable values between 3 and 12 (smaller sizes low values and larger sizes high 
values) and the actual velocities for the paths should be stable, constant and smoothly 
changing values between 0 and 10 m/s.

Store settings on the PC
Store the device settings after verifying the values. 

● Choose: [Device → Upload to PG/PC] to get all the settings.

● Store the complete settings on your PC via [File → Export].

Commissioning
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Functions 7
7.1 Unit selection

The device is delivered with totalizer and flow rate units in m and m3/h, respectively, as 
standard. However, it is possible to manually configure the device to operate with other units.

Changing the units
Go via PDM menu [Device → Unit guide (offline)]. Select the new unit from the list and click on 
[Apply Change of Units]. 

Figure 7-1 Unit selection

Click on the [Download to device] icon to apply the changes.

Note

The display is only able to show m3 and m3/h

If the units are changed to units other than m3 and m3/h, the display will not show any unit 
indication after the measured value on the display. To show the new customer unit on the 
display, a sticker can be used to show units. This sticker should be affixed to the transmitter 
display.
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7.2 Number of decimal digits
For the display values (totalizers in menu 1 and 2 and flow in menu 3) Auto adjust decimal 
point is the default setting. This means that the number of digits after the decimal point 
automatically will be reduced with increasing number of digits before the decimal point.

7.3 Password-protected data
In the Modbus communication via SIMATIC PDM, the flowmeter information is protected by a 
password. The default password is "1000" and it can be changed after gaining access to the 
flowmeter or via the PDM menu [Device → Change Password (Online)]. The password can be 
changed without the use of the HW key.

Figure 7-2 Change password

Click [Write the new password to the device] and [Close].

7.4 Hardware key

HW key
To gain access to protected parameters of the transmitter, a hardware jumper (HW key) must 
be installed as shown below. The HW key place is located internally on the right top part of 
PCB behind the display as shown.

Note

For type-approved and verified FUE380 flowmeter the HW key is protected by a verification 
sealing on the display frame (see Sealing of FUE380). The verification sealing can only be 
opened by the user with the acceptance of the local authorities.

Functions
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Figure 7-3 HW key behind the display (placed on the right pins)

Note
Important

In this mode, with the HW key installed, many parameters in PDM are opened. If these 
parameters are changed, it can seriously affect the meter accuracy and operation. Be careful 
when writing new parameters.

Changing the HW-protected parameters
1. Disconnect power supply to transmitter, i.e. battery plug and the mains power supply

2. Remove frame and display from transmitter.

3. Insert HW key vertically on right pins as shown in figure above.

4. Remount display and frame on transmitter.

5. Restart device.

6. Make parameter changes via PDM.

7. Download parameter changes to device.

8. Remove HW key by following the steps above.

Functions
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Service and maintenance 8
8.1 Maintenance

The device is maintenance-free. However, a periodic inspection according to pertinent 
directives and regulations must be carried out.   

An inspection can include check of:

● Ambient conditions

● Seal integrity of the process connections, cable entries, and cover screws

● Reliability of power supply, lightning protection, and grounds

NOTICE

Repair and service must be carried out by Siemens authorized personnel only.

Note

Siemens defines flow sensors as non-repairable products.     

8.2 Battery replacement

NOTICE

Battery replacement interval

- Only for devices with backup battery - 

It is recommended to replace the battery pack at the latest after 6 years.
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Battery lifetime
The battery lifetime depends on the frequency of mains supply failure. Under normal 
temperature and working conditions a battery can have an operation lifetime of up to 6 years. 

1. Unscrew battery cover and remove old battery pack.

2. Fit new battery pack in transmitter.

8
7
H
1
3
3
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3. Connect battery. 
Ensure that wire is inserted into small channel leading from plug to battery.

4. Remount battery cover.

Note

Every time a battery is fitted and connected, the unit runs a start-up routine.

A battery replacement does not influence the transmitter settings and accumulated process 
values. 

Service and maintenance
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Resetting the internal battery counter
After replacing the batteries, reset the internal battery counter in order to indicate the power 
capacity correctly.

Note
Battery capacity

The transmitter setting for the battery capacity is pre-configured by the ordered version. To 
ensure the correct battery status calculation the replacement battery shall be the same type 
and have the specific capacity. 

8.3 Technical support
If you have any technical questions about the device described in these Operating Instructions 
and do not find the right answers, you can contact Customer Support:     

● Via the Internet using the Support Request: 
 Support request (http://www.siemens.com/automation/support-request) 

● Via Phone:

– Europe: +49 (0)911 895 7222

– America: +1 423 262 5710

– Asia-Pacific: +86 10 6475 7575

Further information about our technical support is available on the Internet at 
 Technical support (http://support.automation.siemens.com/WW/view/en/16604318) 

Service & Support on the Internet
In addition to our documentation, we offer a comprehensive knowledge base online on the 
Internet at: 

Service and support (http://www.siemens.com/automation/service&support) 

There you will find:

● The latest product information, FAQs, downloads, tips and tricks.

● Our newsletter, providing you with the latest information about your products.

● Our bulletin board, where users and specialists share their knowledge worldwide.

● You can find your local contact partner for Industry Automation and Drives Technologies 
in our partner database.

● Information about field service, repairs, spare parts and lots more under Services.

Additional Support   
 If you have additional questions about the device, please contact your local Siemens 
representative and offices at:

Service and maintenance
8.3 Technical support
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Local contact person (http://www.automation.siemens.com/partner)

8.4 Application-specific data - Qualification certificate
In case the device needs service, the technical support team will typically request information 
about the application and the flowmeter.

● Prepare a sketch of the installation/application.

● For your convenience you may create a qualification certificate via SIMATIC PDM

Service and maintenance
8.4 Application-specific data - Qualification certificate
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1. In PDM click on [Device → Qualification Certificate]. 

2. Click on [Generate qualification certificate].

3. Click on [Close].

Service and maintenance
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The Qualification Certificate is now available via Microsoft Word. Add the required application 
information in the document (see Figure 8-1 Qualification certificate (page 1) (Page 69), Figure 
8-2 Qualification certificate (page 2) (Page 70) and Figure 8-3 Qualification certificate (page 
3) (Page 71)).

Figure 8-1 Qualification certificate (page 1)

Service and maintenance
8.4 Application-specific data - Qualification certificate

FUS380/FUE380
Operating Instructions, 09/2016, A5E00730100-AB 69



Figure 8-2 Qualification certificate (page 2)
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Figure 8-3 Qualification certificate (page 3)

8.5 Return procedures
Enclose the delivery note, the cover note for return delivery together with the declaration of 
decontamination form on the outside of the package in a well-fastened clear document pouch.     

Service and maintenance
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Required forms
● Delivery Note

● Cover Note for Return Delivery with the following information
Return delivery form (http://support.automation.siemens.com/WW/view/en/16604370)

– product (ordering number)

– number of devices or spare parts returned

– reason for the return

● Declaration of Decontamination 
Decontamination declaration (http://pia.khe.siemens.com/efiles/feldg/files/Service/
declaration_of_decontamination_en.pdf)
With this declaration you certify that the returned products/spare parts have been carefully 
cleaned and are free from any residues.
If the device has been operated together with toxic, caustic, flammable or water-damaging 
products, clean the device before return by rinsing or neutralizing. Ensure that all cavities 
are free from dangerous substances. Then, double-check the device to ensure the cleaning 
is completed.
We will not service a device or spare part unless the declaration of decontamination 
confirms proper decontamination of the device or spare part. Shipments without a 
declaration of decontamination will be cleaned professionally at your expense before further 
proceeding. 

You can find the forms on the Internet and on the DVD delivered with the device.

Note
Return of products with Lithium batteries  

Lithium batteries are certified as dangerous goods according to the Regulation of Dangerous 
Goods, UN 3090 and UN 3091. Special transport documentation is required to observe these 
regulations. 

Therefore it is recommended to remove lithium batteries prior to shipment

If the battery is important for the examination of the product and it cannot be removed, the 
product has to be returned according to the Regulation of Dangerous goods.

8.6 Battery disposal
In accordance with EU directive 2006/66/EC, batteries are not to be disposed of via municipal 
waste disposal services.

Waste industrial batteries from our products are accepted back by Siemens and by the local 
Siemens representatives. Please follow the return procedures of Siemens or  talk to your local 
Siemens partner (http://www.automation.siemens.com/partner).

Service and maintenance
8.6 Battery disposal

FUS380/FUE380
72 Operating Instructions, 09/2016, A5E00730100-AB

http://support.automation.siemens.com/WW/view/en/16604370
http://pia.khe.siemens.com/efiles/feldg/files/Service/declaration_of_decontamination_en.pdf
http://pia.khe.siemens.com/efiles/feldg/files/Service/declaration_of_decontamination_en.pdf
http://www.automation.siemens.com/partner


Troubleshooting/FAQs 9
9.1 Error codes

A list of error codes is available in SIMATIC PDM (active errors are check-marked). Access to 
this list is gained via [Device → Device Status] in parameter 200 Fault status.. In the figure 
below, error code F 5 is active.

Figure 9-1 List of error codes shown in PDM

Table 9-1 Error codes shown in the display and in PDM 

Error 
code

Error Remedy/Cause

Blank 
display

Battery plug not connected, or battery 
empty, mains power interrupted

● Check flowmeter version. Battery version not 
able to run on mains power

● Battery empty: Replace battery pack
● Battery plug not plugged into the transmitter, 

see Battery replacement (Page 63)
F 1 Path 1 (upper path) not measuring No water in upper part of pipe and/or cables or 

transducer 1A or 1B defective
F 2 Path 2 (lower path) not measuring No water in lower part of pipe and/or cables or 

transducer 2A or 2B defective
F 3 Internal software failure Contact Siemens customer support
F 4 Internal software failure Contact Siemens customer support
F 5 Power supply warning ● Mains power fails (only mains-powered 

versions with battery back-up)
● Replace battery pack (battery-powered 

versions only)
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Error 
code

Error Remedy/Cause

F 6 Flow exceeds preset flow rate in unit 
(max. speed 10 m/s)

Flowrate too high

F 7 Pulse output A overflow Pulse output exceeds 100 Hz or 50% duty cycle
F 8 Pulse output B overflow Pulse output exceeds 100 Hz or 50% duty cycle
F 9 Datalogger warning/alarm Datalogger warning monitors whether actual con‐

sumption on Totalizer 1 is on end of log interval or 
above/below the limit settings. 
The warning has no influence on the flowmetering. 
Check data logger values and consumption limit 
(via PDM parameter 602) 

Errors "F 1" to "F 4" affect the performance of the meter and the flowmeter may stop measuring.
Errors "F 1" and "F 2" disappear when the alarm condition is corrected.
Errors "F 5" to "F 9" are only warnings and do not affect the measurement, but they will influence 
the outputs.
The error indications disappear when the alarm conditions are corrected and a reset via the 
communication interface has been carried out.

Example
Error code "F 1 2" in the display indicates a combination of error codes "F 1" and "F 2".

Possible causes:

● Empty pipe

● Path 1 and path 2 cables defective

● Path 1 and path 2 cables not connected

● Transducers defective

9.2 Diagnosing with PDM
SIMATIC PDM is a suitable tool for diagnosing the device. You can use SIMATIC PDM to read 
all parameters available in FUS080 to a table for analyzing offline, view online/actual process 
values and online/actual diagnostic information.   

Requirements
The following procedure must be completed before diagnosing:

● Connection of Modbus interface via PC and IrDA, see also Commissioning via PDM 
(Page 48)

● Installation of PDM and FUS080 PDM driver, see also Installing the device driver 
(Page 50)
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Diagnosing with PDM
Access the device status via [Diagnostic → Device Status].

Online process values are available under menu [View → Display].

The Measured Track Values tab shows the gain steps and the flow velocities for path 1 and 
path 2. For 1-path applications the values for path 2 (track 2) are 0.

The gain steps depend on the pipe size and the conditions of the measuring media.

The flow velocities depend on the flow in the pipe.

Troubleshooting/FAQs
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① Gain step
② Gain step max
③ Gain step min
④ Transducer distance [mm]

Figure 9-2 SITRANS FUS080 Gain step vs. Transducer distance

Gain step

The graph above shows which gain step to expect for a particular transducer distance (face 
to face distance). The upper curve indicates the upper limit and the lower curve indicates the 
lower limit. 

The graph applies to perfectly aligned transducers in clean water, but takes into account the 
expected variance from the converter and the transducers. 

Gain step error conditions

Condition Cause
15 ● No transducer (e.g. defective cable)

● Empty pipe
High values ● High damping (e.g. inhomogeneous media)

● Unsuitable medium
● Path angular misalignment

Unstable/fluctuating values ● Air bubbles or solids in medium
● Bad inlet conditions

Δ gain step between path 1 and path 2 > 1
(2-path systems only)

● Bad inlet conditions
● Inhomogeneous medium
● Path angular misalignment

Troubleshooting/FAQs
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In case of angular misalignment between transducer faces, the gain step will increase as 
shown in the table below:

Angular misalignment Gain step increase
2° 1
3° 2
4° 3
5° 5

Flow velocity error conditions

Condition Cause
Δ flow velocity values (between path 1 and path 2) 
> 1
(2-path systems only)

● Bad inlet conditions (the higher the delta, the 
worse the inlet conditions)

● Disturbances in the pipe (bad flow profile)
Unstable/fluctuating values ● Air bubbles or solids in media

● Bad inlet conditions

The actual velocities for the paths should be stable, constant and smoothly changing values 
between 0 and 10 m/s.
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Technical data 10
10.1 FUS380 and FUE380 systems

Table 10-1 Technical data SITRANS FUS380 and FUE380

Description Specification
Enclosure design/material Fiber glass reinforced polyamide in light-gray color
Enclosure IP67 according to EN 60529 and DIN 40050 (NEMA 4X/6)
Wall mounting kit Terminal box made of fiber glass reinforced polyamide in light-gray 

color with 2 + 2 cable glands (output, supply and transducer cables) 
and a stainless steel bracket for wall or pipe mounting

Cable glands In wall mounting kit:
● 4 x M20 PA plastic cable glands (2 for mains and output cable, 

2 for the transducer coaxial cables)
Ambient temperature  -10 °C to +55 °C (14 °F to 131 °F) 1)

Storage temperature −40 °C to + 85 °C (−40 °F to +185 °F) 
Transducer/sensor cables ● Coaxial cable, impedance 75 Ohm, ∅ app. 6 mm;

● Remote version cable length: Max. 30 meter between transmitter 
and transducer (5 m (16.4 ft), 10 m (32.8 ft), 20 m (65.6 ft), or 30 
m (98.4 ft) available). 

Mechanical vibration 2 g, 1 to 800 Hz sinusoidal in all directions according to IEC 68-2-6 
Power supply Battery 2): 

● Replacable 3.6 V LiSOCI (Lithium Thionyl Chloride)
● Double battery pack 34 Ah or single backup battery 17 Ah;
● Battery exchange interval: 4.2 (6) years at 60°C (140°F) 

operation
Mains:
● 87 to 265 V AC (50 to 60 Hz)

Display ● LCD, 8 digits, additional 2 digits and symbols for status 
information

● Units: Volume unit: m3 (default display unit), Flow unit: m3/h 
(default display unit)

● Alarm codes (F 1 to F 9) for: path 1 or 2 not measuring, internal 
failure, power supply failure, flow overload, pulse output 
frequency overload, data logger warning

Push button One push button for toggling between display information 
Measuring function ● 0.5 Hz (battery mode)

● 15 Hz (mains-powered)
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Description Specification
Outputs (standard) ● Two passive, galvanically isolated open drain-mos outputs 

(output A and B)
● Max. ±35 V, 50 mA
● Output A: Preset to pulse output for forward flow (default: 100 l/

pulse)
● Output B: Preset to alarm for present failure
● Pulse with: 5, 10, 20, 50, 100, 200, 500 ms (default: 5 ms)
● Max. pulse frequency: 100 Hz at Qmax setting (105% of Qs)

EMC performance ● Emitted interference to EN 55011/CISPR-11
● Immunity to EN/IEC 61326-1 (Industry)
● MID approved (FUE380 series): Environment class E2 and M1

Transmitter weight 1.5 kg (3 lb) 
Communication IrDA on display panel (Modbus RTU protocol) 
Approvals ● Approval standards: EN 1434 and OIML R 75 Class 2 

● Type approval: MID, MI-004, class 2 approval and certification 
(according to EN 1434)

● CPA/CMC (China)

1) MID: environment class -10°C to +55°C (14°F to 131°F)
2) Waste industrial batteries are accepted back by the producer or importer, who has originally 
marketed the battery, or by the producer or importer, where the new industrial battery is 
purchased.

10.2 Battery

Table 10-2 Battery types

Description Specifications
Main battery
(for battery-powered 
versions)

Replaceable 3.6 V LiSOCl (Lithium Thionyl Chloride) dual battery pack 34 
Ah of two D-cell types

Back-up battery
(for mains-powered ver‐
sions)

Single battery 17 Ah of one D-cell type

Note

The batteries are not rechargeable; they should be replaced after maximum 6 years.   

Consumption and battery operation time calculation

For battery versions, the battery operation time depends on the connected battery pack as 
well as the operation conditions of device. 

Technical data
10.2 Battery
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Every 5 minutes the advanced power management system of the transmitter calculates the 
battery consumption and the remaining battery operation time.

For battery versions, only the internal battery pack has a nominal capacity of 34 Ah giving a 
typical operation time up to 6 years in a revenue application.

The ambient temperature of the transmitter also influences the battery capacity.

The typical operation time up to 6 years is based on only 80% battery capacity, low pulse 
output frequency, seldom use of communication and an operation time/temperature profile of 
5% at 0 °C (32 °F), 80% at 15 °C (59 °F) and 15% at 50 °C (122 °F).

The effect of other temperatures is shown in the figure below.

A variation in temperature from 15 °C to 55 °C (59 °F to 131 °F) reduces the capacity by 17% 
(in the figure from 15 Ah to 12½ Ah).

Note

The installation orientation of the battery pack may influence the battery capacity. Optimal 
battery capacity is achieved with the battery pack in an upright position.

10.3 Sensor for FUS380 and FUE380

Table 10-3 Technical data

Description Specification
Pipe design 2-track sensor with flanges and integrated transducers wet-calibrated from 

factory
Nominal size DN 50, 65, 80, 100, 125, 150, 200, 250, 300, 350, 400, 500, 600, 700, 800, 

900, 1000, 1200
Pressure rate PN 16, PN 25, PN 40

EN 1092-1 flanges:
● type 01: DN 100 to DN 125
● type 11: DN 150 to DN 1200
● type 11 'design': DN 50 to DN 80

Technical data
10.3 Sensor for FUS380 and FUE380
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Description Specification
Pipe materials ● DN 100 to 1200: Carbon Steel EN 1.0345 / p235 GH, painted in light gray

● DN 50 to DN 80: Die-cast bronze G-CuAn 10/W2.1050.01 (EN1982)
Transducer design ● DN 100 to 1200: Integrated version and welded onto the pipe

● DN 50 to 80: Screwed into the pipe
Transducer material Stainless steel (AISI 316 / 1.4404) / brass (CuZn36Pb2As)
Media temperature DN 100 to 1200: 

● Remote: 2 to 200 °C (35.6 to 392 °F) 1)

DN 50 to 80: 
● Remote: 2 to 150 °C (35.6 to 302 °F) 1)

DN 50 to 1200:
● Compact: 2 to 120 °C (35.6 to 248 °F) 1)

Measured media Heating water, according to VDI-2035 (pH 8.2 - 10.5), industrial VdTÜV in‐
formation sheet 1466 and AGFW information sheet FW 510

1) MID: minimum temperature 15 °C (59 °F)

10.4 Dimensional drawings for FUS380 and FUE380

Transmitter IP67/NEMA 4X/6, wall mounting

10.5 Sensor dimensions for FUS380 and FUE 380

Size PN 16 PN 25 PN 40    
 L Weight L Weight L Weight Material A1 Lift

hugDN mm kg mm kg mm kg  mm
50 -   - 300 +0/-2 10 Bronze 350 No
65 -   - 300 +0/-2 15 Bronze 363 No

Technical data
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Size PN 16 PN 25 PN 40    
 L Weight L Weight L Weight Material A1 Lift

hugDN mm kg mm kg mm kg  mm

80 -   - 350 +0/-2 18 Bronze 370 No
100 350 +0/-2 15  - 350 +0/-2 18 Steel 372 No
125 350 +0/-2 18   350 +0/-2 24 Steel 385 No
150 500 +0/-3 28   500 +0/-3 34 Steel 399 No
200 500 +0/-3 38 500 +0/-3 47 500 +0/-3 55 Steel 425 Yes
250 600 +0/-3 60 600 +0/-3 76 600 +0/-3 91 Steel 452 Yes
300 500 +0/-3 66 500 +0/-3 81 - - Steel 478 Yes
350 550 +0/-3 94 550 +0/-3 121 - - Steel 495 Yes
400 600 +0/-3 124 600 +0/-3 153 - - Steel 520 Yes
500 625 +0/-3 194 625 +0/-3 231 - - Steel 570 Yes
600 750 +0/-3 303 750 +0/-3 365 - - Steel 622 Yes
700 875 +0/-3 361 875 +0/-3 565 - - Steel 673 Yes
800 1000 +0/-3 494 1000 +0/-3 770 - - Steel 724 Yes
900 1230 +0/-6 535 1300 +0/-6 835 -  Steel 775 Yes
1000 1300 +0/-6 594 1370 +0/-6 1000 - - Steel 826 Yes
1200 1360 +0/-6 732 -  -  Steel 928 Yes

Size PN 16 PN 25 PN 40     
 L Weight L Weight L Weight Material A1 A2 Lift

huginch inch lb inch lb inch lb  inch inch
2 - - - - 11.81 

+0/-0.08
22 Bronze 13.78 7.72 No

2 1/2 - - - - 11.81 
+0/-0.08

33 Bronze 14.30 8.11 No

3 - - - - 13.78 
+0/-0.08

40 Bronze 14.57 8.50 No

4 13.78 
+0/-0.08

33 - - 13.78 
+0/-0.08

40 Steel 14.65 8.70 No

5 13.78 
+0/-0.08

40 - - 13.78 
+0/-0.08

53 Steel 15.16 8.90 No

6 19.68 
+0/-0.12

62 - - 19.68 
+0/-0.08

75 Steel 15.71 9.29 No

8 19.68 
+0/-0.12

84 19.68 
+0/-0.12

104 19.68 
+0/-0.12

121 Steel 16.74 10.24 Yes

10 23.62 
+0/-0.12

132 23.62 
+0/-0.12

168 23.62 
+0/-0.12

201 Steel 17.80 11.26 Yes

12 19.68 
+0/-0.12

146 19.68 
+0/-0.12

179 - - Steel 18.82 12.28 Yes

14 21.65 
+0/-0.12

207 21.65 
+0/-0.12

267 - - Steel 19.49 13.43 Yes

Technical data
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Size PN 16 PN 25 PN 40     
 L Weight L Weight L Weight Material A1 A2 Lift

huginch inch lb inch lb inch lb  inch inch

16 23.62 
+0/-0.12

273 23.62 
+0/-0.12

337 - - Steel 20.48 13.90 Yes

20 24.61 
+0/-0.12

428 24.61 
+0/-0.12

509 - - Steel 22.45 15.91 Yes

24 29.53 
+0/-0.12

668 29.53 
+0/-0.12

805 - - Steel 24.49 17.91 Yes

28 34.45 
+0/-0.12

796 34.45 
+0/-0.12

1246 - - Steel 26.50 19.92 Yes

32 39.37 
+0/-0.12

1089 39.37 
+0/-0.12

1698 - - Steel 28.51 21.89 Yes

36 48.43 
+0/-0.24

1179 51.18 
+0/-0.24

1841 -  Steel 30.52 23.86 Yes

40 51.18 
+0/-0.24

1310 53.94 
+0/-0.24

2205 - - Steel 32.52 25.83 Yes

48 53.54 
+0/-0.24

1614 -  -  Steel 36.54 29.76 Yes

Weight for transmitter/electronics 1.5 kg (3.3 lb) (compact version) or approximately 5 kg (11 
lb) (remote version including 10 m (32.8 ft) cable set).
For flange values - see norm EN 1092-1.
- means not available.

All weights are approximate. 
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Parameter lists A
The following tables show the various parameters available via PDM.

The parameters are accessible at three different levels:

● Read: Maintenance level

● Read/Write (R/W): Specialist level (write access is only permitted after entering the user 
password; default password is 1000)

● Hardware locked (HW key): The parameter is only accessible when a HW key is mounted

Note

For type-approved and verified FUE380 flowmeter the settings are HW key protected and 
therefore read only. This HW key is protected via the verification sealing. The verification 
sealing can only be opened by the user with the acceptance of the local authorities.

A.1 Identification

Table A-1 Identification parameters (FW 2.03 and EDD 1.02.08-01)   

Modbus 
Address

Parameter Default val‐
ue 

Value range Access 
level

Description

40049 1 Application identifier Identity  R/W Customer application identification in‐
formation (max 16 characters)

40057 2 Application location Location  R/W Customer application location informa‐
tion (max 16 characters)

Device
40032 5 Sensor size Product de‐

pendent
 R/W Pipe diameter of the sensor. It is only 

a text field for measurement system in‐
formation. The value has no influence 
on the measurement. Please see inner 
diameter at pipe date in parameter 306

40141 8 Totalizer unit m3 See Table 
A-6 Totalizer 
units 
(Page 96)

R/W Totalizer unit as text for volume. 
Change the unit in parameter table if 
the device menu "Unit guide (offline)" 
does not list the wanted unit.
Note: The device display can show 
"m3" unit only - other units cannot be 
shown on the display, but will be used 
and shown online via PDM
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Modbus 
Address

Parameter Default val‐
ue 

Value range Access 
level

Description

40135 9 Flowrate unit m3/h See Table 
A-7 Flow rate 
units 
(Page 96)

R/W Flow unit as text for actual flowrate. 
Change the unit in parameter table if 
the device menu "Unit guide (offline)" 
does not list the wanted unit.
Note: The device display can show 
"m3/s" unit only - other units cannot be 
shown on the display, but will be used 
and shown online via PDM.

40129 10 Maximum flow Qmax  R/W Maximum flow
40008 20 Vendor name Siemens A/

S
 Read Siemens A/S Flow Instruments, Den‐

mark
40001 21 Module type Product de‐

pendent
0 to 14 Read Type of flowmeter

40002 22 Software version 2.03   Software version of the flowmeter
40022 23 Product code number Product de‐

pendent
  Siemens production sales code num‐

ber (the first part of the system number 
on the nameplate)

40014 24 System Serial num‐
ber

Product de‐
pendent

 R/W Siemens production number (the s 
econd part of the system number on 
the nameplate

40065 25 Transmitter serial 
number

Product de‐
pendent

 HW key Serial number of the electronics

40073 26 Sensor serial number Product de‐
pendent

  Serial number of the sensor

A.2 Output

Table A-2 Output parameters 

Modbus 
Address

Parameter Default 
value 

Value range Ac‐
cess 
level

Description

43023 100 Actual date and time Product 
depend‐
ent

 R/W Actual date and time (day-month-
year and hours:minutes:seconds)

43006 101 Totalizer 1 0 -2000000001 
to 
+2000000001

Read Volume for totalization register 1

43010 102 Totalizer 2 0 -2000000001 
to 
+2000000001

Read Volume for totalization register 2

43014 103 Customer totalizer 3 0  Read Customer totalizer 3 based on total‐
izer 1 set up

19 104 Reset customer totalizer 3 No No, Yes R/W Reset of customer totalizer
40732 105 Customer totalizer 3 reset 

date
Last reset 
date

dd-mm-yyyy, 
hh:mm:ss

 Date and time when customer total‐
izer has been reset
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Modbus 
Address

Parameter Default 
value 

Value range Ac‐
cess 
level

Description

43001 106 Flow rate   Read Actual flow value
43136 107 Relative flow rate 0  Read Actual flow value in relation to Qmax
43035 108 Actual velocity for path 1 0  Read The actual flow velocity for path 1 in 

m/s (SI-unit)
43046 109 Actual velocity for path 2 0   The actual flow velocity for path 2 in 

m/s (SI-unit). 
Valid for 2-path solutions only

43026 110 Path 1 gain step 15 1 to 15 Read Amplifier setting when measuring 
path 1

43037 111 Path 2 gain step 15 1 to 15 Read Amplifier setting when measuring 
path 2. 
Valid for 2-path solutions only

Pulse A B
40817 430 Output A enable Product 

depend‐
ent

No, Yes R/W Select "Yes" to enable output A

40818 431 Pulse A direction Forward Forward, Re‐
verse, For‐
ward net, Re‐
verse net

R/W Pulse output calculation on pure for‐
ward flow or pure reverse flow - or net 
flow for forward and reverse pulse 
flow. 
Valid if pulse output A is enabled

40819 432 Amount per pulse A Product 
depend‐
ent

0.000001 to 
1000000000

R/W Volume per pulse and selected unit 
Valid if pulse output A is enabled.

40821 433 Pulse width for pulse A Product 
depend‐
ent

5, 10, 20, 50, 
100, 200, 500 
ms

R/W Pulse length when the pulse is ac‐
tive. 
Valid if pulse output A is enabled

40822 440 Output B enable Product 
depend‐
ent

No, Yes R/W Select "Yes" to enable output B

40823 441 Pulse B function Product 
depend‐
ent

Pulse, Alarm, 
Call up

R/W Configuration of output B as pulse - 
alarm or call up function. 
Valid if pulse output B is enabled

40824 442 Pulse B direction Reverse Forward, Re‐
verse, For‐
ward net, Re‐
verse net.

R/W Pulse output calculation on pure for‐
ward flow or pure reverse flow - or net 
flow for forward and reverse pulse 
flow. 
Valid if pulse output B is enabled and 
pulse function selected

40825 443 Amount per pulse B Product 
depend‐
ent

0.000001 to 
1000000000

R/W Volume per pulse. 
Valid if pulse output B is enabled and 
pulse function selected

40827 444 Pulse width for pulse B Product 
depend‐
ent

5, 10, 20, 50, 
100, 200, 500 
ms

R/W Pulse length when the pulse is ac‐
tive. 
Valid if pulse output B is enabled and 
pulse function selected
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Modbus 
Address

Parameter Default 
value 

Value range Ac‐
cess 
level

Description

Communication
For editing the communication settings, use PDM device menu "Communication Setting"
40833 591 Device Communication Ad‐

dress
1 1 to 247 Read Meter has default address value 1 

with selectable address up to 247
40834 592 Baudrate 4 0 to 5 Read Communication port speed
40835 593 Parity 0 0 to 3 Read Communication port parity
40836 594 Interframe space 35 35 to 255 Read Minimum space between two mes‐

sages (bytes x 10)
40837 595 Response delay 5 1 to 50 Read Minimum time from receiving a re‐

quest to its response
Data logger
40619 600 Log interval Monthly Daily, Weekly, 

Monthly
R/W Log interval

40620 601 Day of week, if weekly log Sunday Monday to 
Sunday

R/W When log interval is set to weekly 
logging, this parameter defines what 
weekday the logging is performed. 
Valid if weekly log interval is activated

40621 602 Limit for too high consump‐
tion

1E+09 -3.4E+38 to 
+3.4E+38

R/W Limit for too high consumption during 
current log interval. Based on totaliz‐
er 1 and the selected unit 

40623 603 Limit for too low consump‐
tion

-1E+09 -3.4E+38 to 
+3.4E+38

R/W Limit for too low consumption during 
current log interval. Based on totaliz‐
er 1 and the selected unit

22 604 Reset log No No, Yes HW 
key

Reset data logger

Periodic log Totalizer 1
40770 160 Next settling date 01-01-200

0
dd-mm-yyyy R/W Next settling date where actual value 

of totalizer 1 is stored
40773 161 Latest settling date 01-01-200

0
dd-mm-yyyy Read Latest settling date where value of 

totalizer 1 was stored
40776 162 Latest totalizer 1 value 0  Read Latest stored value of totalizer 1
40780 163 Previous settling date 01-01-200

0
 Read Previous settling date where value of 

totalizer 1 was stored
40783 164 Previous totalizer 1 value 0 dd-mm-yyyy Read Previously stored value of totalizer 1

A.3 Diagnostic

Table A-3 Diagnostic   

Modbus 
Address

Parameter Default 
value

Value 
range   

Access 
level

Description

Diagnostic
40804 500 Latest service date 01-01-200

0
dd-mm-
yyyy

R/W* Latest service date (can also be used for 
date of installation)
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Modbus 
Address

Parameter Default 
value

Value 
range   

Access 
level

Description

40808 501 Operating hours since 
power up

0 3.4E+38 h Read Total operation hours since last power 
up

40807 503 Numbers of power up 0 0 to 65535 Read Total number of power-ups since first 
power-up.

Alarm
43005 200 Fault status  One or 

more of 
the follow‐
ing val‐
ues: 1, 2, 
3, 4, ... up 
to 16

Read Fault status
1: Path 1 error
2: Path 2 error
3: Dual slope calibration error
4: Database checksum error
5: Low power warning
6: Flow overload warning
7: Pulse A overload warning
8: Pulse B overload warning
9: Consumption interval error
10: Leakage error (not used)
11: Hardware calibration error
12: Not used
13: Not used
14: Not used
15: Not used
16: Not used

40346 202 Date of fault log reset Last reset 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Date of last fault log reset

14 204 Reset the fault log and 
faults

No No, Yes R/W Reset the fault log and faults

15 205 Call up acknowledge No No, Yes R/W Select "Yes" to reset active call-up
21 209 Reset consumption log 

fault
No No, Yes R/W Reset the consumption fault. 

Caused by too low or too high consump‐
tion in the log interval

3 210 Path 1 alarm output ena‐
ble

Yes No, Yes R/W Select "Yes" to enable current alarm on 
alarm output / call-up

40257 211 Path 1 fault hours e.g. 36 h Read;  Total hours fault active
40258 212 Path 1 fault counter e.g. 4 0 to 65535 Read Total number of faults. 

Valid only if alarm is enabled
40259 213 Path 1 fault appears Last fault 

appear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Last time the fault appeared. 
Valid only if alarm is enabled

40262 214 Path 1 fault disappears Last fault 
disappear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Last time the fault disappeared. 
Valid only if alarm is enabled

4 215 Path 2 alarm output ena‐
ble

Yes No, Yes R/W Select "Yes" to enable active alarm on 
alarm output / call-up. 
Valid only for 2-path solutions
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Modbus 
Address

Parameter Default 
value

Value 
range   

Access 
level

Description

40265 216 Path 2 fault hours e.g. 36 h Read; Read Total hours fault active. 
Valid only for 2-path solutions and if 
alarm is enabled

40266 217 Path 2 fault counter e.g. 4 0 to 65535 Read Total number of faults. 
Valid only for 2-path solutions and if 
alarm is enabled

40267 218 Path 2 fault appears Last fault 
appear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read First time the fault appeared. 
Valid only for 2-path solutions and if 
alarm is enabled

40270 219 Path 2 fault disappears Last fault 
disappear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Last time the fault disappeared. 
Valid only for 2-path solutions and if 
alarm is enabled

5 220 Dual slope alarm output 
enable

Yes No, Yes R/W Select "Yes" to enable active alarm on 
alarm output / call-up

40273 221 Dual slope fault hours e.g. 0 h 0 to 65535 Read Total hours fault active. 
Valid only if alarm is enabled

40274 222 Dual slope fault counter e.g. 0 0 to 65535 Read Total number of faults. 
Valid only if alarm is enabled

40275 223 Dual slope fault appears Last fault 
appear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read First time the fault appeared. 
Valid only if alarm is enabled

40278 224 Dual slope fault disap‐
pears

Last fault 
disappear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Last time the fault disappeared. 
Valid only if alarm is enabled

6 225 Parameter checksum 
alarm output enable

Yes No, Yes R/W Select "Yes" to enable active alarm on 
alarm output / call-up

40281 226 Parameter checksum 
fault hours

e.g. 0 h 0 ... 65535 Read Total hours fault active. 
Valid only if alarm is enabled

40282 227 Parameter checksum 
fault counter

e.g. 0 0 ... 65535 Read Total number of faults. Valid only if alarm 
is enabled

40283 228 Parameter checksum 
fault appears

Last fault 
appear 
date

dd-mm-
yyyy,
hh:mm:ss

Read First time the fault appeared. 
Valid only if alarm is enabled

40286 229 Parameter checksum 
fault disappears

Last fault 
disappear 
date

dd-mm-
yyyy,
hh:mm:ss

Read Last time the fault disappeared. 
Valid only if alarm is enabled

7 230 Low power alarm output 
enable

Yes No, Yes R/W Select "Yes" to enable active alarm on 
alarm output / call-up

40289 231 Low power fault hours e.g. 0 h 0 to 65535 Read Total hours fault active.
Valid only if alarm is enabled

40290 232 Low power fault counter e.g. 0 0 to 65535 Read Total number of faults. 
Valid only if alarm is enabled

40291 233 Low power fault appears Last fault 
appear 
date

dd-mm-
yyyy,
hh:mm:ss

Read First time the fault appeared. 
Valid only if alarm is enabled
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Modbus 
Address

Parameter Default 
value

Value 
range   

Access 
level

Description

40294 234 Low power fault disap‐
pears

Last fault 
disappear 
date

dd-mm-
yyyy,
hh:mm:ss

Read Last time the fault disappeared. 
Valid only if alarm is enabled

8 235 Flow overflow alarm out‐
put enable

Yes No, Yes R/W Select "Yes" to enable active alarm on 
alarm output / call-up

40297 236 Overflow fault hours e.g. 0 h 0 to 65535 Read Total hours fault active.
Valid only if alarm is enabled

40298 237 Overflow fault counter e.g. 0 0 to 65535 Read Total number of faults. 
Valid only if alarm is enabled

40299 238 Overflow fault appears Last fault 
appear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read First time the fault appeared. 
Valid only if alarm is enabled

40302 239 Overflow fault disappears Last fault 
disappear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Last time the fault disappeared. 
Valid only if alarm is enabled

9 240 Pulse A overload alarm 
output enable

Yes No, Yes R/W Select "Yes" to enable active alarm on 
alarm output / call-up

40305 241 Pulse A overload fault 
hours

e.g. 0 h 0 to 65535 Read Total hours fault active. 
Valid only if alarm is enabled

40306 242 Pulse A overload fault 
counter

e.g. 0 0 to 65535 Read Total number of faults. 
Valid only if alarm is enabled

40307 243 Pulse A overload fault ap‐
pears

Last fault 
appear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read First time the fault appeared. 
Valid only if alarm is enabled

40310 244 Pulse A overload fault 
disappears

Last fault 
disappear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Last time the fault disappeared. 
Valid only if alarm is enabled

10 245 Pulse B overload alarm 
output enable

Yes No, Yes R/W Select "Yes" to enable active alarm on 
alarm output / call-up

40313 246 Pulse B overload fault 
hours

e.g. 0 h 0 to 65535 Read Total hours fault active. 
Valid only if alarm is enabled

40314 247 Pulse B overload fault 
counter

e.g. 0 0 to 65535 Read Total number of faults. 
Valid only if alarm is enabled

40315 248 Pulse B overload fault ap‐
pears

Last fault 
appear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read First time the fault appeared. 
Valid only if alarm is enabled

40318 249 Pulse B overload fault 
disappears

Last fault 
disappear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Last time the fault disappeared. 
Valid only if alarm is enabled

11 250 Consumption alarm out‐
put enable

Yes No, Yes R/W Select "Yes" to enable active alarm on 
alarm output / call-up

40321 251 Consumption fault hours e.g. 0 h 0 to 65535 Read Total hours fault active. 
Valid only if alarm is enabled

40322 252 Consumption fault coun‐
ter

e.g. 0 0 to 65535 Read Total number of faults. 
Valid only if alarm is enabled
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Modbus 
Address

Parameter Default 
value

Value 
range   

Access 
level

Description

40323 253 Consumption fault ap‐
pears

Last fault 
appear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read First time the fault appeared. 
Valid only if alarm is enabled

40326 254 Consumption fault disap‐
pears

Last fault 
disappear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Last time the fault disappeared. 
Valid only if alarm is enabled

12* 255 Leakage alarm output en‐
able

Yes No, Yes R/W Select "Yes" to enable active alarm on 
alarm output / call-up

40329 256 Leakage fault hours e.g. 0 h 0 to 65535 Read Total hours fault active. 
Valid only if alarm is enabled

40330 257 Leakage fault counter e.g. 0 0 to 65535 Read Total number of faults. 
Valid only if alarm is enabled

40331 258 Leakage fault appears Last fault 
appear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read First time the fault appeared. 
Valid only if alarm is enabled

40334 259 Leakage fault disappears Last fault 
disappear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Last time the fault disappeared. 
Valid only if alarm is enabled

13* 260 Empty pipe alarm output 
enable

Yes No, Yes R/W Select "Yes" to enable active alarm on 
alarm output / call-up

40337 261 Empty pipe fault timer e.g. 0 h 0 to 65535 Read Total hours fault active. 
Valid only if alarm is enabled

40338 262 Empty pipe fault counter e.g. 0 0 to 65535 Read Total number of faults. 
Valid only if alarm is enabled

40339 263 Empty pipe fault appears Last fault 
appear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read First time the fault appeared. 
Valid only if alarm is enabled

40342 264 Empty pipe fault disap‐
pears

Last fault 
disappear 
date

dd-mm-
yyyy, 
hh:mm:ss

Read Last time the fault disappeared. 
Valid only if alarm is enabled

Service
17 510 Fixed flow mode enable Yes No, Yes R/W Select "Yes" to force the device to show 

a fixed flow value
Default must be "No"
Always manually reset the value to "No"

40801 511 Fixed flow value 0 -1E+09 to 
1E+09

R/W Fixed flow value for enabled fixed flow 

40803 515 Controlling output A and 
B

Auto Auto, 
Forced

HW key Control of output A and B is used to stop 
or force the output A and/or B.
For editing, use device menu "Service". 
Valid if pulse output is enabled

Power
43120 130 Consumed battery ca‐

pacity
e.g. 
2.054239 
Ah

 Read The amount of energy consumed since 
last time the battery was replaced. 
Valid only for battery-powered versions
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Modbus 
Address

Parameter Default 
value

Value 
range   

Access 
level

Description

40808 501 Operating hours since 
power up

1105 h 3.4 E+38 Read Total operation hours since first power 
up

40807 503 Numbers of power up e.g. 4 0 to 65535 Read Total number of power-ups since first 
power-up.

18 540 Battery change enable No No, Yes R/W Select "Yes" to set battery installation 
date to current date and reset remaining 
battery operation capacity to maximum. 
Valid only for battery-powered versions

40881 541 Battery installation date last bat‐
tery instal‐
lation date

dd-mm-
yyyy; 
hh:mm:ss

Read Latest installation date of batteries. 
Valid only for battery-powered versions

40880 542 Power supply mode Product 
depend‐
ent

Battery 
only, 
Mains on‐
ly, Mains 
with back‐
up battery.

Read The flowmeter is either powered by bat‐
tery only, mains only or by mains with 
battery backup.
The type is defined by the order code 
and cannot be changed.

40849 543 Actual battery capacity Product 
depend‐
ent

0 to 50 R/W** The capacity of the battery in Ah
- Single 16.5 Ah
- Dual battery pack 33.0 Ah
Valid only for battery-powered versions

40851 544 Battery alarm limit 80 0 to 90 R/W Present an alarm when the consumed 
energy superceeds this percentage of 
the battery capacity. 
Valid only for battery-powered versions

* Not supported for FUS080

** Maintenance = Read only

A.4 Meter setup

Table A-4 Meter setup parameters   

Modbus 
Address

Parameter Default 
value 

Value 
range

Access 
level

Description

Meter Setup
40179 307 Flow velocity offset 0 m/s -10 to 10 

m/s
HW key Velocity added to measured flow veloc‐

ity
40182 310 Calibration factor 1.0 0 to 2 R/W This calibration factor will be calculated 

at the factory with wet-calibration.
For FUS080-SONOKIT (retrofit) instal‐
lations this parameter should be calcu‐
lated by the pipe geometric tool (see 
"Pipe geo. assistant" in "Device" menu)
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Modbus 
Address

Parameter Default 
value 

Value 
range

Access 
level

Description

40151 311 Adjustment Factor 1 - 2 to 2 R/W Meter correction factor for customer ad‐
justment of the calculated flow value. 
Can be used at installations where a 
reference meter is used to get reference 
to the true flow rate

40196 312 Transducer cable length Product 
dependent

0 to 200 m R/W Cable length (m) from sensor to trans‐
mitter

40173 372 Filter time constant Product 
dependent

0 to 100 s R/W General time filter for flow measure‐
ment. Filter constant is the time that 
must pass before the filter's ouput value 
is at 70% of the change of its input val‐
ue. Higher number gives a slower and 
more stable flow signal. 

40162 373 Low flow cut-off Product 
dependent

0 to 10 R/W If the flow comes below this percentage 
of Qmax, then the flow value is set to 
zero

40164 374 Creep lock max number 10 0 to 20 R/W Alternative cut-off for totalizing and puls‐
ing.
If the totalized flow within this number 
(N) of samples exceeds [(N x Qmax x 
low flow cut off)/100], the amount is ac‐
cepted for pulsing.
ΣQ > N x Qmax x low flow cut-off/100
● ΣQ: totalized flow within N samples 
● N: Creep lock max number

40184 380 Protect linearization 
from user access.

No No, Yes Read Protection of the linearization parame‐
ters. It is decided by the order number 
and cannot be changed.
The linearization parameters are listed 
in the device menu "Linearization"

Totalizer
40673 400 Flow direction totalizer 1 Forward Forward, 

Reverse, 
Net

R/W Calculation principle on flow direction 
for forward, reverse or net flow

40675 401 Totalizer 1 change date Last 
change 
date

dd-mm-
yyyy; 
hh:mm:ss

Read Date and time when totalizer 1 function 
was changed

40674 410 Flow direction totalizer 2 Reverse Forward, 
Reverse, 
Net

R/W Calculation principle on flow direction 
for forward - reverse or net flow

40678 411 Totalizer 2 change date Last 
change 
date

dd-mm-
yyyy; 
hh:mm:ss

Read Date and time when totalizer 2 function 
was changed

Pipe data
40181 300 Number of paths Product 

dependent
2 R/W Number of paths on the sensor

40149 302 Max sample frequency 15 15 Read The maximum frequency for flow meas‐
urement
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Modbus 
Address

Parameter Default 
value 

Value 
range

Access 
level

Description

40147 303 Sample frequency 0.5 15 HW key The frequency at which the flow is 
measured

40167 304 Rn for path 1 Product 
dependent

3.4E+38 
m

Read R-factor for path 1.
For FUS080/SONOKIT (retrofit) instal‐
lations this parameter will automatically 
be calculated by the pipe geometric tool 
(see "Pipe geo. assistant" in "Device" 
menu).

40169 305 Rn for path 2 Product 
dependent

3.4E+38 
m

Read R-factor for path 2.
For FUS080/SONOKIT (retrofit) instal‐
lations this parameter will automatically 
be calculated by the pipe geometric tool 
(see "Pipe geo. assistant" in "Device" 
menu).
Valid only for 2-path solutions

40171 306 Inner pipe diameter Product 
dependent

0.050 to 
1.200 m

Read Inner pipe diameter in meters.
For FUS080/SONOKIT (retrofit) instal‐
lations this parameter will automatically 
be calculated by the pipe geometric tool 
(see "Pipe geo. assistant" in "Device" 
menu).

A.5 Human Interface

Table A-5 Human Interface parameters   

Modbus 
Address

Parameter Default 
value

Value range Access 
level

Description

40757 420 Decimal point Automatic 
point ad‐
just

No point; 
One digit af‐
ter point; 
Two digits 
after point; 
Three digits 
after point; 
Automatic 
point adjust.

R/W Decimal numbers for displayed total‐
ized value

40753 422 Operator Menu 1 All 1 to 5 Read 
only

Menu setup
1. Totalizer 1
2. Totalizer 2
3. Actual flow rate
4. Error menu
5. Display test menu
For editing, use device menu "Human 
Interface"

Parameter lists
A.5 Human Interface
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A.6 Unit conversion table
The following tables show examples of totalizer and flow rate units. More are available via 
SIMATIC PDM tool

Table A-6 Totalizer units

Unit Correction factor
Default 1 m3

m3*100 0.01
Gallon (US) 264.1721
G*100 (100*Gallon) 2.641721
G*1000 (1000*Gallon) 0.2641721
MG (1000000*Gallon) 0.0002641721
AI (Acre Inches) 0.009728558
AF (Acre ft) 0.0008107132
CF*100 (100*ft3) 0.3531467
CF*1000 (1000*ft3) 0.03531467
I*100 (liter) 10
kI (1000*liter) 1
MI (Mega liter) 0.001

Table A-7 Flow rate units

Flow rate Correction factor parameter
Default 1 m3/s
m3/min (m3/minute) 60
m3/h (m3/hour) 3600
m3/d (m3/day) 86400
GPS (Gallon/second) 264.1721
GPM (Gallon/minute) 15850.32
GPH (Gallon/hour) 951019.4
GPD (Gallon/day) 22824465
MGPD (1000000*Gallon/day) 22.824465
CFS (ft3/second) 35.31467
CFM (ft3/minute) 2118.882
CFH (ft3/hour) 127132.8
I/s (liter/second) 1000
I/min (liter/minute) 60000
I/h (liter/hour) 3600000
MI/d (1000000lLiter/day) 86.4

Parameter lists
A.6 Unit conversion table
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Settings B
B.1 Factory settings

The transmitter is configured at the factory according to the order specification.

For the calibration / configuration of the flowmeter the application specific pipe dimensions and 
the specific transducer locations can require an update (for example transmitter is used with 
the SONOKIT sensor system).

Note

For type-approved and verified FUE380 flowmeter the settings are HW key protected and 
therefore read only. This HW key is protected via the verification sealing. The verification 
sealing can only be opened by the user with the acceptance of the local authorities.

Table B-1 Factory settings for 2-path sensor (DN 50 to DN 1200)   

Parameter Factory settings Possible settings 
Meter identification - Free text 15 characters 
Application location - Free text 15 characters 
Display menu Menu 1 – 5 (all) Menu 1 – 5, minimum one of the five
Pipe data 
Number of paths 2 1 or 2 
Inner pipe diameter (m) for FUE380 and FUS380 factory pre-

configured according order code
May not be changed

Q max Qmax is 105% of Qs (Qs is shown on 
the system nameplate). For FUE380 
and FUS380 factory pre-configured ac‐
cording the selection via order code.

Adjustable 

Low flow cut-off (% of Qmax) 0.25 % 
For FUE380 and FUS380 factory pre-
configured. It is %-value related to the 
Qmax setting. The %-value is equal to 
50% of Qi (Qi is shown on the system 
nameplate).

Adjustable (0 to 10%) 

Fliter time constant Factory pre-configured to typical 5 s (for 
larger pipe size higher values are used)

Adjustable (5 to 1000 s)

Geometry factor path 1 For FUE380 and FUS380 factory pre-
configured according order code

Auto set from pipe geometry help pro‐
gram in PDM

Geometry factor path 2 For FUE380 and FUS380 factory pre-
configured according order code

Auto set from pipe geometry help pro‐
gram in PDM 

Correction factor 
Customer correction factor 1 0.5 to 1.5 
Measuring unit and factors 
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Parameter Factory settings Possible settings 
Flow unit factor 3600 (for flow unit m3/h) Auto set from unit guide 
Totalizer volume unit factor 1 Auto set from unit guide 
Flow unit text m3/h Auto set from unit guide, but only m3/h 

can be shown on display
Totalizer unit text m3 Auto set from unit guide, but only m3 can 

be shown on display 
Totalizer directions 
Totalizer 1 direction Forward Forward/Reverse/Forward net/Reverse 

net 
Totalizer 2 direction Reverse Forward/Reverse/Forward net/Reverse 

net 
Output A
Active On On/off 
Direction Factory pre-configured according order 

code. 
Preset: Forward 

Forward/Reverse/Forward net/Reverse 
net 

Amount per pulse Factory pre-configured according order 
code, i.e. 0.1 m3

Unit: The same as Totalizer unit
Value freely selectable 

Pulse width Factory pre-configured according order 
code. Typically 5 ms 

5, 10, 20, 50, 100, 200, 500 ms 

Output B
Active On On/Off 
Function Alarm Pulse/Alarm/Call up 
Direction No influence, while "Alarm" Forward/Reverse/Forward net/Reverse 

net 
Amount per pulse No influence, while "Alarm" Unit: The same as Totalizer unit

Value freely selectable
Pulse width No influence, while "Alarm" 5, 10, 20, 50, 100, 200, 500 ms 

B.2 Factory settings for Modbus communication

Parameter Default setting
Slave device address 1
Data transmission rate 19 200 baud
Vertical parity position Even 1 stop
Response timeout 10000 ms
Response delay 5 ms
Interframe space 35 bits

The settings can be changed via SIMATIC PDM or via the Modbus. 

Settings
B.2 Factory settings for Modbus communication
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B.3 Ordering of spare parts
Ensure that your ordering data is not outdated. The latest ordering data is always available on 
the Internet: Process instrumentation catalog (http://www.siemens.com/
processinstrumentation/catalogs)

Settings
B.3 Ordering of spare parts

FUS380/FUE380
Operating Instructions, 09/2016, A5E00730100-AB 99

http://www.siemens.com/processinstrumentation/catalogs
http://www.siemens.com/processinstrumentation/catalogs


Settings
B.3 Ordering of spare parts
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